
OsoSoft's WinClip 4.0
(Unregistered Shareware Version)

INTRODUCTION 
When working with Windows 3.x software, it's often easiest to standardize on 
BMP, PCX, and WMF files for your clip art needs.  Most Windows program can 
handle these images, and most paint programs, including Windows PaintBrush, 
included with Windows 3.1, can produce and edit most of these files, although 
PaintBrush can't handle WMF files.

Unfortunately, it's been difficult to view these files quickly or to print a catalog of 
your clip art images. Until WinClip, that is. WinClip allows you to view your BMP 
PCX, and WMF files on screen, then print a catalog of all your files, or just the 
ones you select.  For your convenience, WinClip can also display and print ICO, 
RLE, DIB, and TGA files, and can convert all but PCX and TGA files to  standard
BMP format. WinClip is so easy to use that you may not need any documentation
at all.  It uses the standard Windows 3.1 conventions, relying on buttons 
primarily, rather than menu commands.

LICENSE INFORMATION
WinClip is a shareware program. You may use it for a trial period of up to 30 
days. After that time, you must pay for and register your copy of the program. 
The registration fee is only $20. Fully-paid registered users will receive the very 
latest version of the program, a printed manual, and are entitled to full support by
phone, fax, mail, BBS and on CompuServe. Registered users are also entitled to 
unlimited free upgrade downloads on the OsoSoft BBS and in OsoSoft's 
CompuServe support area. Other upgrades will incur a small charge. 

NOTE: Non-registered users receive only a bare minimum of support, and 
are not entitled to telephone support at all. 

To pay for and register your copy, run the program. In the Help menu is an entry 
for OsoSoft Program Information. There, you can get information on all 
OsoSoft programs and fill out an order blank on screen. When you're done, click 
the [Print] button to print out a copy, then mail it with your payment to the 
address on the form. All checks must be drawn on a U. S. Bank, payable in US 
dollars.

You can also pay and register by credit card (MasterCard or Visa) on the OsoSoft
BBS at 805-528-3753, by voice at 805-528-1759, or you can fax your order form 
to OsoSoft at 805-528-3074. 

CompuServe users may also pay and register on CompuServe. Just type GO 



SWREG at any system prompt, then find the program and register it. Charges 
are added to your CompuServe bill.

Registration Reminder Screens
From time to time, on exiting from WinClip, you'll see the  About window, which 
reminds you to pay for your copy of the program. This screen will not appear in 
registered versions. To hear a message, if you have a sound card, click on the 
speaker button. To access the Order form, click the Register button. Click OK to 
exit to Windows.

Distribution
Users of this program, along with traditional shareware distributors may distribute
copies of  the shareware versions of this program, but only under the terms 
described in the VENDOR.DOC file included with this copy of the program. All 
commercial distributors MUST read that file and abide by the distribution rules 
contained in that file. Violations of the distribution license in VENDOR.DOC may 
result in prosecution under appropriate copyright laws of the United States and 
other countries.

OsoSoft is a member of the Association of Shareware Professionals and the 
Software Publishers' Association.

OsoSoft
1472 Sixth Street
Los Osos, CA  93402
OsoSoft BBS: (805) 528-3753
Voice Order Line: (805) 528-1759
FAX Order Line: (805) 528-3074
CompuServe ID: 71571,222 or GO OSOSOFT

HOURS
OsoSoft business hours are 7 AM to 4 PM, Pacific Time, on weekdays. Calls 
outside those hours are not appreciated.

ASP OMBUDSMAN NOTICE
This program is produced by a member of the Association of Shareware 
Professionals (ASP). ASP wants to make sure that the shareware principle works
for you. If you are unable to resolve a shareware-related problem with an ASP 
member by contacting that member directly, ASP may be able to help. The ASP 
Ombudsman can help you resolve a dispute or problem with an ASP member, 
but does not provide technical support for members' products. Please write to the
ASP Ombudsman at 545 Grover Road, Muskegon, MI 49422-9427 USA FAX 
619-788-2765 or send a CompuServe message via CompuServe mail to ASP 
Ombudsman 70007,3536.
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SYSTEM REQUIREMENTS 
WinClip requires a 386 or better PC, Windows 3.1 operating in Enhanced Mode, 
and a minimum of 2 MB of memory. You'll also need 2 MB of disk space for 
installation and up to 6 MB of free disk space for TMP files if you use Print 
Manager. NOTE: For fastest results, turn Print Manager off in the Control 
Panel's Printer Setup application before starting WinClip. You'll also need a 
fully-supported Windows-compatible printer with a 100% correct printer driver 
and a valid video display with 640 X 480 resolution minimum.

OSOSOFT BBS
Please feel free to call the OsoSoft BBS at any time. The number is (805) 528-
3753, and you may call at any baud rate from 300-14400. Set your parameters to
8 bits, No parity, and 1 stop bit. The latest shareware versions of OsoSoft 
programs are always online, along with clip art collections and a number of free 
programs from OsoSoft. If you have a modem, be sure to call!

OsoSoft Support on CompuServe
OsoSoft maintains a support area on CompuServe for your convenience. To 
access the area, use the GO command OSOSOFT. That will take you to the 
Windows Applications E Forum. Message and File area 5 are dedicated to 
OsoSoft. You'll always find the latest versions of all OsoSoft programs there.

WinClip Features
Supports BMP, PCX, WMF Files Plus Others
Supports 1, 4, 8, and 24-bit Images
Supports all displays
Preview Images On Screen with Scroll Bars
Print Single Image, with Filename
Print Image Catalogs of All or Selected Images with Filenames
Zoom Images from 10% to 500% On Screen and To Printer
AutoZoom fits your image, in proportion in the viewing windows.
Edit Any Image Automatically in Your Favorite Image Editor 
Copy Image files to New Locations
Move Image files to New Locations
Delete Image files
Supports CD-ROM Clip Art Collections
Supports all Windows-compatible Graphics Printers.
NEW! Set thumbnail image sizes from .5 to 1.5 inches for neater pages.
NEW! Supports ICO, RLE, DIB, and TGA files.
NEW! Convert WMF, ICO, RLE, DIB files to standard BMP files

SYSTEM REQUIREMENTS
WinClip requires Windows 3.1 or later, running in Enhanced mode, a hard disk 
and a mouse. 2 MB of RAM is required, but 4 MB is recommended. If you use 
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Print Manager, you'll also need additional disk space to handle the TMP files 
created by Print Manager. To edit images, you'll also need Windows PaintBrush 
or another program which can edit BMP and PCX files. WMF file editing requires 
a program capable of handling that format.

WinClip supports all Windows graphics-compatible printers. The quality of dot 
matrix support will depend on the individual printer. Your printer must be able to 
handle a full page of graphics at its maximum resolution. For best results, disable
Print Manager when using WinClip.

IMPORTANT NOTICE: WHY NO GIF SUPPORT?
Previous versions of WinClip supported the GIF image format, introduced by 
CompuServe as a standard graphics format. However, due to a patent dispute 
with UNISYS, a large computer company, GIF support has been dropped from 
this program. OsoSoft regrets having to do this, but since UNISYS insisted that 
royalties be paid on even unregistered copies of the program, OsoSoft has joined
many other software publishers in discontinuing support for this file format until 
the situation is resolved.

INSTALLING WINCLIP 
WinClip was written in Microsoft Visual Basic 3.0. All Visual Basic 3.0 programs 
require a run-time library, VBRUN300.DLL, which must be located in your 
WINDOWS\SYSTEM directory. If you do not have a copy of this file, you can 
obtain it from almost any BBS, shareware vendor, or from the OsoSoft BBS.

WinClip also requires PPORIENT.DLL, QPRO200.DLL, and CSPICTUR.VBX, 
and CMDIALOG.VBX, all of which can be found on your distribution disk or in the
ZIP file containing this program. These programs are copyright by their 
respective publishers.

To install WinClip, first create a directory for the program (C:\OSOSOFT) using 
the DOS MakeDir (MD) command or the Windows File Manager. You can also 
install the program in any other directory you wish.  Next, copy all files from your 
distribution disk into that directory.

Then, copy *.DLL,  and *.VBX into your WINDOWS\SYSTEM directory. Once 
you've copied these files, you can then delete them from your WinClip directory.

NOTE: If you do not wish to copy the DLL and VBX files to your WINDOWS\
SYSTEM directory, you may leave them in the directory where you installed 
WinClip. However, in this case, you must be sure that the Working Directory field 
is properly filled out in the Properties dialog in Program Manager, as described 
below.

Now, start the Windows Program Manager and click on the program group where
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you want to place the WinClip icon. Next, click on the File menu in Program 
Manager, then click on New. Click OK in the next dialog box, then type WinClip 
in the Description: field of the next dialog box.  

Press <Tab> and type the whole path and filename for WinClip in the Command 
Line: field. Your entry should look something like this, with the appropriate path 
substituted, if necessary:

C:\OSOSOFT\WINCLIP.EXE

Press <Tab> again, then enter the path to the WinClip directory in the Working 
Directory: field. Don't type a backslash here. This entry should look like this, 
again, using the directory where you copied the program:

C:\OSOSOFT 

Click [OK] to finish the installation. The WinClip icon will appear in the program 
group which was current when you added the new icon.  You may have to scroll 
the program group window to find the icon, but then you can drag it wherever you
like.

UnInstalling WinClip
Should you choose to uninstall WinClip, first remove the WinClip Icon from 
Program manager. Click once on the icon, then press the <Del> key. Answer Yes
to the prompt. To delete the program files, use File Manager or the DOS 
DELTREE command to remove the directory where you installed WinClip. You 
may have copied several DLL and VBX files into your WINDOWS\SYSTEM 
directory. You may refer to the installation instructions above for the names of 
these files, which you may wish to delete. CAUTION: The DLL and VBX files 
installed with WinClip may be required by other programs on your system. Use 
caution before deleting these files if you copied them into WINDOWS\SYSTEM.

RUNNING WINCLIP 
To start WinClip, just double-click on the WinClip icon.  After a brief delay, you'll 
see the program's main window.On the left of the windows are drive, directory 
and file lists. Across the top of the window are option buttons and commands. To 
the right is the image display window.

Menu Commands 
On the top line are three menu items: File, Options, and Help. Since WinClip 
uses command and option buttons, these menus are extremely simple.

File Menu
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Printer Setup—This command takes you to the standard Windows Printer Setup
dialog box. Use this command if you need to change any printer settings.

Exit—As expected, this command exits WinClip.

Options Menu
Set Paint Program—WinClip allows you to automatically load the on-screen 
image into your favorite graphics program. The default program is Windows 
PaintBrush. If you wish to use this program to edit images, you don't need to do 
anything. If, however, you want to use another editor, give this command. You'll 
see a dialog box. Enter the complete path and filename for the editor you want to
use. NOTE: The editor you select must be able to load a file from its command 
line. In most cases, the default PaintBrush application will do the job.

Set AutoShow Delay Time—Use this command to set the time, in seconds, 
each image stays on the screen when you click the AutoShow button to display 
each image in turn automatically. The default setting is 2 seconds.

Printer Thumbnail Size—WinClip now lets you choose a size for the images on 
your catalog printouts. You can select Natural Size or any of the fixed 
measurements listed in the submenu. Notice that .5" images produce more than 
150 images per page, a very economical way to print your catalogs. Sizes 
available for thumbnails are .5", .75", 1", and 1.5"

Custom Printout Text—WinClip lets you create a short text line to be printed on 
your catalogs. If you do not create a custom text line, none will be printed.

Save Options as Defaults—This command lets you save most options set in the
program as default settings. Settings saved include the Paint Program, Custom 
Text, Default Thumbnail size, and AutoZoom Settings. If you choose this 
command, the current directory showing your images will also be saved.

Delete Saved Option Settings—Use this command to remove the custom 
option settings and revert to WinClip default settings.

Help Menu
Help with WinClip—This command opens the Help window. On the left, you'll 
see a topic list, with help information on the right. To view help on a topic, simply 
click on that topic in the topic list. Information on your selection will appear at the 
top of the right window. To return to your program, click the [Exit] button or the 
Return to WinClip menu item.

About—This command displays version information about WinClip, along with 
contact information on OsoSoft. 
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OsoSoft Program Information—OsoSoft publishes several other program 
which may interest you. For information on those products, to register WinClip, or
to order any OsoSoft program, give this command. To see information on a 
product, click the [Info] button next to that product's name. To order, fill out the 
order blank by pressing <Tab> or <Enter> and type the appropriate information 
in the fields that appear. When you're ready to print the form, just click the [Print]
button. To return to the WinClip screen, click the [Cancel] button.

USING WINCLIP
WinClip is designed to be extremely easy to use. All commands do exactly what 
they say they do, and prompts and confirmation windows pop up whenever 
they're needed. The entire program is designed to make viewing and working 
with clip art images as easy as possible.

Viewing Images
Start by selecting the drive and directory where your images are stored, using 
normal Windows techniques. Double-click on directory names to change 
directories and display the file list. A list of files, along with the total number of 
files displays at the lower left of the window. To view an individual file, click once 
on the filename. The image will appear in the viewing box to the right. Just above
the viewing box, you'll see the complete path and filename of the image, its size 
in pixels and the bit count per pixel of the image.

Just above the drive selection list are two rows of option buttons, which let you 
view a single type of file or all file types in the file selection list. The default is to 
display all files, but you can click any of the options to view just the images you 
choose.

If you're viewing an 8 or 24-bit image on a monitor which cannot display all the 
available colors, WinClip will do its best to display the colors or gray scale in the 
image. However, for best results, you should use WinClip with a display that can 
correctly display the full range of colors for your particular image.

Once the image is in the screen, you can scroll to view different parts of large 
images by using the scroll bars to the right and below the image display window.

Mark the AutoZoom check box to automatically size images to fit inside the 
window. Proportions will remain correct.  This box is checked by default when 
you start the program.

Selecting Multiple Images
Since WinClip can operate on multiple images, you'll often want to select more 
than one image. To select consecutive images in the file list box, hold down the 
left mouse button and drag the highlight over the files you want to select. If you 
need to select filenames which are not consecutive, hold down the <Ctrl> key 
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while you click on as many filenames as you like. You can combine these two 
techniques to select any combination of files. These are standard Windows list 
selection methods. The last file you select always becomes the current file and 
displays in the window.

Zooming Images
To view the current image in a larger or smaller size, click the [Zoom] button. In 
the dialog box, type in the percentage of zoom you want. You can view any 
magnification or reduction from 10% to 500%, depending on the original size of 
the image. If you select a zoom factor too large for the image to print on your 
printer, you'll see a warning and the image will return to normal 100% 
magnification. All Zoom factors are measured from the original size of the image.

Since the default in the Zoom dialog box is always 100%, you can easily return 
to the original size by clicking the [Zoom] button, then clicking [OK] without 
typing anything. The current Zoom percentage always appears on the [Zoom] 
button.

IMPORTANT NOTE: The Zoom factor you select applies to printed images as 
well as to the screen, if you're using the Natural Size Option for printing. In most 
cases you'll want to reset the Zoom factor to 100% before printing. However, if 
you're working with very large or very small images, a different Zoom factor may 
make your printouts easier to view.

Remember, the AutoZoom check box lets you see your images all in the same 
size in your window. This is the fastest way to simply preview images, and it 
enlarges tiny images so you can see details.

Stepping Through Images
To step through the images in the current list, click the [AutoShow] button. You'll 
see each image in 2-second intervals, or at the interval you set in the Options 
menu. To stop stepping, click the [Cancel] button, or press <Esc>. For easiest 
viewing, turn on the AutoZoom feature.

Converting Images to BMP Files
WinClip can now convert WMF, ICO, RLE, and DIB files to standard BMP files. 
When you select one of these files, the [Convert to BMP] button appears. Click 
it if you want to convert the file, then accept the proposed file name, or enter your
own filename. If the proposed file exists, you'll be asked whether you want to 
overwrite the existing file. NOTE: You can include path information if you want to 
save the converted file to a new directory. If you make an error with the file name,
WinClip will prompt you for a new file name.

HINT: If you're working with graphics on a CD-ROM drive, you cannot save 
converted files to the same drive as proposed by WinClip. You'll need to provide 
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full path information with each new file name or you'll see an error message. 
Consider moving the files to a directory on your hard disk before converting.

Printing Images
WinClip lets you print your images in several ways. Select the button that best fits
your needs.

NOTICE FOR UNREGISTERED USERS
All sheets with multiple images printed with the unregistered version of 
WinClip will carry the watermark, "Created with WinClip 4.0 -- Unregistered 
Version," near the top of the page. This watermark will not interfere with 
your evaluation of the program. The registered version of the program 
does not display this text on printouts.

[Print Current]—This button prints the current image at the current 
magnification. The image's filename appears above the image in the printout.

[Print All]—This button prints all images in the file list. Each image will appear on
the screen as it is sent to the printer. The printout names the directory and prints 
the filename above each image. Images are printed in the size selected in the 
Options menu. The default thumbnail size is 1" wide. For larger or smaller 
images, choose another thumbnail size.

[Print Selected]—This button prints all images selected in the file list. The format
is the same as when you print all files. 

Cancelling a Print Job
At any time during printing of multiple files, click the [Cancel] button or press 
<Esc> to cancel printing. Printing will cease after the current image.

Printing Speed
Please be patient during printing. Printing large numbers of graphical images can
take some time, especially on dot-matrix or PostScript printers. As long as the 
mouse pointer is still movable on the screen, things are going OK. HINT: You can
speed up printing somewhat by turning off Print Manager in the Printer dialog box
from the Windows Control Panel.

NOTE: While WinClip can display and print almost all formats it supports, there 
are some obscure file formats which it cannot handle, particularly some files 
originally created on Macintosh computers. If you encounter one of these 
images, you'll see a dialog box telling you that the image is in an invalid format. 
During printing, the image will appear blank on the page. Try loading the file into 
a graphics program and save it with a new format.

Editing Images
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WinClip can automatically load the current image, as displayed in the viewing 
window, into a graphics editor of your choice. The default editor is Windows 
PaintBrush, but you can choose any editor you wish in the Options/Set Paint 
Program menu, as described above. Note that PaintBrush can only edit BMP and
PCX files.

To load an image for editing, select a file in the file list, then click the [Edit 
Image] button. Your chosen program will appear maximized, with the image on 
the screen. When you exit the graphics program, you'll return automatically to the
WinClip screen. Reselect the file to view the changes you've made.

SHORTCUT: You can also edit an image by double-clicking on either the 
filename or inside the viewing window.

Managing Image Files
One of WinClip's most powerful features is its ability to manage image files. You 
can delete one or more files, copy files to another directory or disk, or move the 
files to another location. It's just as easy to do these advanced functions as it is to
view or print an image. All file management commands are on command buttons 
described below:

[Copy]—To copy one file or all the files you've selected in the file list, first select 
the files, then click this button. A dialog box will appear. Type in the destination 
drive and directory, then click [OK]. Your files will be copied without any further 
input. When copying is finished, you'll be informed.

[Move]—This button works exactly like the [Copy] button, but once the files are 
copied to the destination directory, they are deleted from their current directory. A 
dialog box will ask you to confirm this operation. All copies are checked for 
validity before the original is deleted.

NOTE: You must enter a valid path in the dialog boxes for both the above 
commands. If you name a path that doesn't exist, you'll get an error message 
and no copying will be done. Use the Windows File Manager to create a directory
if necessary.

HINT: Use the [Copy] and [Move] functions to set up and maintain clip art 
directories according to your needs. You can copy and move to and from floppy 
disks or even copy from a CD-ROM collection of clip art, copying just the images 
you need to your system.

[Delete]—Use this button to delete the files currently selected in the file list. You'll
be asked to confirm your action just once. Be very careful not to accidentally 
delete files you may not want to delete. Scroll through the file list from top to 
bottom before giving this command to make sure only files you want to delete are
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selected. WinClip assumes you know what you want to do, and warns you only 
once before doing what you ask.

WINCLIP TIPS AND HINTS
The size of a printed image depends on the printer's resolution. For example, a 
300 X 300  pixel image will print as a 1-inch square on most laser printers. If you 
want a larger printout, use the [Zoom] button to increase the magnification.

Don't forget that you can elect to print all images as equal sized thumbnail 
images automatically. Set the thumbnail size in the Options menu.

If you encounter an "Invalid Image Format" error, you can safely assume that the 
image will cause problems in many other programs. Try loading the image into a 
graphics program, then save it in another format to avoid later problems. You'll 
have to do this outside of WinClip however.

WinClip always uses the current default printer setup, but forces the printer into 
portrait mode before printing. Make sure you have the correct printer driver 
installed as the default before running WinClip or use the Printer Setup 
command to change printers.

WinClip prints its sheets with a 1.25" margin. This allows you to use a three-hole 
punch on the pages and store them for quick reference.

On color printers, you should see color images in color. However, this depends 
on your printer driver settings and on the abilities of your printer. If you're not 
getting color printouts, check your printer settings.

WinClip makes every attempt to display images as well as it can. However, if you
try to display a 24-bit color image on a 16-color display, you'll get far less color 
definition. The printout will reflect the display's colors, not the colors in the image.
For best results, use a display mode which matches the images you're 
cataloging.

Be very careful with the [Move] and [Delete] commands in WinClip. Make sure 
the files you have selected are the ones you want to move or delete. You're 
always asked for confirmation, so double-check.

Neither OsoSoft nor WinClip is responsible for errors caused by your video
display or printer driver! There are a number of defective drivers in use, and 
manufacturers are constantly updating their drivers. If you experience problems 
when using WinClip, such as unexplained crashes or General Protection Faults, 
your first suspect should be your display or printer driver. Make certain you have 
the most current driver for your display or printer. WinClip does nothing out of the
ordinary while displaying or printing images. The program has been thoroughly 
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tested with correctly functioning video and printer drivers.

SPECIAL VIDEO DRIVER NOTE: If you use some video displays and drivers 
which handle more than 256 colors, WinClip may not print images at all. Some 
defective drivers may even cause a crash. If this occurs, switch to a driver which 
displays 256 colors or less, using the Windows Setup icon in Program Manager.

WinClip and all related files created by OsoSoft, including this documentation are
Copyright 1991,1995 by OsoSoft. All rights are reserved.
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